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Chapter 1 – Introduction 

This instruction manual provides comprehensive guidance on the 
operation and maintenance of the FM 301 Blasting Seismograph. It 
specifically applies to the FM 301 units designated as the 1000 
Series, which begin with serial number 1000. 

The FM 301 is an advanced digital blasting seismograph designed 
for the monitoring of vibration and air overpressure resulting from 
blasting in surface mines, underground mines, quarries and other 
operations employing explosives. 

The specification for the FM 301 is given in appendix 1. 

 

 

 

 

 

 

 

 

 

 

 

Handling Procedures 

• Handle all equipment and accessories with care. 

• Do not operate the equipment if the unit has been damaged. 
Immediately turn the instrument off and have it inspected 
by a Blast Log repair facility. 

• Ensure that the USB connector is fully inserted. 

• Ensure the connectors are clean prior to use. 

L 

T 

USB Port On/Off Switch 

Microphone 

Indicator LEDs 
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• Do not pull the cord when connecting or disconnecting the 
USB cable. Align the connector to the port before inserting. 
Never force the connector. 

• To ensure proper operation charge the battery immediately 
when the FM 301 indicates a low battery condition. 

• The battery used in this device may present a fire or 
chemical burn hazard if mistreated. DO NOT disassemble 
the battery, heat it above 60oC (140oF) or incinerate. 

• Do not open the unit. 

• The FM 301 seismograph is water resistant. Do not 
immerse in water. Clean with a damp cloth. 

• The vibration sensors employed in the FM 301 are 
accelerometers meaning that the unit can be used in any 
orientation and does not need to be level to give valid 
results.  

Vibration Sensors 

The vibration sensors employed in the FM 301 are accelerometers 
meaning that the unit can be used in any orientation and does not 
need to be level to give valid results.  

The use of accelerometers also gives enhanced reliability compared 
to other seismographs using moving mass geophones. Conversion 
from acceleration to velocity is carried out in the unit giving peak 
results for both acceleration and velocity. 

USB Interface 

The unit has a USB interface and comes with Windows software to 
allow for the downloading and analysis of the full waveforms for 
each recording made, as well as changes to monitoring parameters 
such as trigger levels and recording duration.  

Bluetooth 

The FM 301 has a Bluetooth Low Energy interface which enables 
the unit to be controlled from an application that can be run on any 
Android equipped device, such as a mobile phone. 
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Battery Life 

Battery life depends upon the mode of operation but is typically in 
the order of 24 hours of continuous monitoring. Charging of the 
internal batteries is also done via the USB interface. 

GPS 

The unit is also equipped with a GPS system meaning that, when a 
GPS signal is available, the location of the unit is stored with each 
recording. The use of the GPS also results in highly accurate timing 
data meaning that multiple seismographs can be time synchronised. 

Note : The position accuracy of the GPS is dependant on the 
orientation of the satellites, signal blockage and atmospheric 
conditions.  

The typical position accuracy of the FM 301 seismograph is 
between 4 to 20 metres.   

Internal Storage 
Internal data storage is included meaning that the full waveform 
recordings are stored for the last 1000 events recorded. 

Dimensions and Weight 
Despite the high specification of the FM 301 it comes in a single 
relatively small package weighing less than 1 kg with dimension of 
160 mm x 138 mm x 55 mm. 

Mounting 
As standard each FM 301 comes equipped with levelling feet for 
use on solid surfaces and spikes for use on soils. The two through 
holes are available for permanently mounting on a solid surface. 

LED Indicators 
The FM 301 is equipped with bright indicator red, green and blue 
LEDs in the top of the unit which are used to show the status and 
operation of the unit. 
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Chapter 2 – Charging 

Charging the seismograph 
Charging of the internal batteries is achieved by connecting to any 
powered USB port with the supplied USB lead.  

As a rough guide, if the unit is used for one hour then it will need 
charging for one hour.  

It is useful to note that all the time the unit is connected to a 
powered laptop or other computer then charging will be taking 
place so it can be useful to leave your FM 301 connected to a 
powered USB port on your computer. 

The battery level is indicated when the unit is turned on or can be 
seen using the Android App. The battery level should only be 
assessed when the unit is not being charged via the USB port. 

Do not charge overnight. 
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Chapter 3 – FM 301 Operations 

Setup Monitoring Parameters  
Before going into the field the monitoring parameters should be set 
via the supplied Windows software (see section below). For a 
typical monitoring operation the following parameters are 
recommended: 

• Record Window : 4 seconds 
• Vibration Trigger Level : 0.5 mm/s 
• Air Overpressure Trigger Level : 115 db(Linear) 

 

Note that the trigger levels can also be changed during monitoring 
via the Android App – see the App section below for more 
information. 

The monitoring parameters are stored in non-volatile memory and 
will be used when the machine is turned on. 

Field Setup 

The FM 301 comes with a set of levelling feet for use on solid 
surfaces and spikes for use in soils.  

Whilst the unit can be operated in any orientation there is a 
levelling bubble included for use if desired. 

Monitoring Start  
With the FM 301 in position, and correctly setup, monitoring can 
be started by turning the machine on via the On/Off button.  

Note : The On/Off button is Off when the button is depressed and 
On when the button is raised. This is to reduce the chance of the 
power being accidently turned on in the carrying case. 

Initial LED Indications 
On turning on the unit, the LEDs will be tested by showing the 
following sequence: 
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• 2 Reds for 1 second 
• 2 Greens for 1 second 
• 2 Blues for 1 second 

 

The battery level will then be indicated by two red, two green or 
two blue LEDs indicating the following. 

• 2 Greens = OK for several hours 
• 2 Blues = OK for one hour 
• 2 Reds = Less than one hour and the machine could stop 

monitoring at any time 
• 2 Reds (flashing) = No monitoring can be carried out and 

the unit requires charging 
 

Monitoring Process 
Monitoring will continue until the machine is powered down by 
pressing the On/Off button.  

Monitoring status is indicated by the LEDs as follows : 

• Right flashing green = monitoring active. 
• Right flashing blue = monitoring active with a valid GPS 

signal. 
• Right red = monitoring but triggered 
• Right blue = data processing and storage in progress 

 

The flashing rate for the LEDs is synchronised to the recording 
window that has been set e.g. for a 4 second window the LEDs will 
flash every 4 seconds. 

If the left and right red LEDs flash left and right continuously then 
there is insufficient power and monitoring will be suspended.  

Note : In this case the machine should be turned off to avoid the 
risk of running the batteries too low causing permanent damage. 

Monitoring End 
The FM 301 will continue to monitor and automatically add the 
recordings to the internal memory. When the memory capacity of 
1,000 events has been reached the unit will overwrite the oldest 
recording. 
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The unit can be turned off at anytime via the On/Off button. 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



Blast Log Ltd 8 

 

FM 301 Blasting Seismograph - Instruction Manual    •   8 
 

Chapter 4 – V-Blast Windows 
Software 

Connecting via a USB Port  
The FM 301 can be connected to any Windows PC, that meets the 
minimum requirements, using the supplied USB/Charging cable. 

Setting the FM 301 into USB Communication Mode  
Before transferring data to and from the FM 301 using the USB 
cable, the unit needs to be set into USB mode.  

Setting this mode disables triggering meaning that the unit can be 
left powered up on a desk without getting false triggers.  

Setting USB mode is achieved on turning the unit on by tapping the 
top of the unit each time the pair of LEDs is lit.  

That is two taps to correspond to the Red, Green and Blue LEDs.  

If the tap is successfully registered the LEDs will flash.  

As an alternative the same effect can be achieved by pick the unit 
up and shaking it gently during the LED sequence.  

If you have successfully started the USB mode the lefthand LED 
will then show continuously green. 

Running the V-Blast software  
After launching the V-Blast software, the main window will open 
displaying a blank interface with a menu bar. All operations related 
to file management, data download, and configuration are 
accessible via the menu options described in the following sections. 

 

File :  Open 

Selecting File → Open allows previously saved waveform files to 
be opened within the software. 
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These files use the .FMD extension and contain full waveform 
recordings captured by the FM 301. 

Download 

Selecting Download → Local (USB Connection) opens a new 
window for connecting to an FM 301 device and managing event 
file transfers. 

Once connected, event recordings stored on the unit can be viewed, 
selected, and downloaded to the computer for further analysis or 
archiving. 

 

 

 

 

 

 

 

 

 

 

 

 

 

When the Download from Seismograph via USB Connection 
window opens, two connection options are available: 

• Auto Connect 

• Select COM Port (manual selection) 
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Before proceeding, ensure the FM 301 is: 

• Connected to the PC using the supplied USB charging 
cable 

• Powered on and placed in USB communication mode, 
indicated by a solid white right LED 

Note: If the unit is powered on and the right LED is solid white, 
but the software displays "Error: No Valid Comms Port 
found.", the PC has not successfully established 
communication. 

In this case: 

• Ensure that only one unit is connected 

• Retry using Auto Connect, or manually select the 
correct COM port 

• Check the USB connection and confirm that the unit is 
not still completing its startup sequence  

 

Once the device is ready, click Auto Connect. The software will 
attempt to automatically detect and connect to the FM 301. 

If Auto Connect is unsuccessful, use the Select COM Port drop-
down to manually choose the correct port. 

 

Once a connection is established, the software will display a list of 
the most recent 20 recorded events, including the date, time, and 
peak values for both vibration and air overpressure. 

Additional options are available to view a larger set of events: 

• Last 100 Events – Displays the most recent 100 
recordings 

• All 1000 Events – Displays the full history of recordings 
stored in the unit’s memory  

Note: Do not close the window while the event summary is 
loading. Closing the window during this process may cause the 
software and FM 301 to become unresponsive. 
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The software will also display the serial number of the connected 
FM 301 unit and the assigned COM port. 

To download event files: 

1. Select one or more events from the list using the 
checkboxes 

- or  - 

Enter an Event ID into the Event ID input box 

2. Click Download Event(s) 

3. A progress bar will indicate the transfer status 

4. When complete, a file browser will prompt for a 
destination folder 

Warning: Some Events Records Were Invalid and are Not 
Listed 

If the message “Warning: Some Events Records Were Invalid 
and are Not Listed.” appears, this indicates that one or more 
event records could not be displayed in the summary list. 

To attempt recovery of missing events: 

• Close the warning window 

• Review the displayed Event ID list 

• Identify any missing Event IDs 

• Enter each missing ID into the Event ID input box 

• Click Download Event(s) 
If successful, the progress bar will indicate download progress, 
and a file browser will prompt for the destination folder when 
complete. 

 

Multiple recordings can be downloaded simultaneously. All files 
are saved using a standard 18-digit filename format: 

YYYYMMDDHHMMSS####.FMD, where: 

• YYYY = Year 

• MM = Month  
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• DD = Day 

• HH = Hour 

• MM = Minute 

• SS = Second 

• #### = Unit serial number 

For example: 
202507221211432010.FMD 
(Recorded on July 22, 2025 at 12:11:43 by unit 2010) 

It is recommended to organise files by site and location using 
clearly named directories for future reference. 

Setup :  Seismograph 

Before accessing the setup screen, ensure the FM 301 is correctly 
connected and in USB communication mode. 

Failure to do so will result in the error message: 
"Error: No Valid Comms Port found." 

To avoid this, confirm the following: 

• The unit is connected to the PC via the supplied USB 
charging cable 

• The unit is powered on and in USB communication 
mode (indicated by a solid white right LED) 

Once confirmed, select Setup → Seismograph → Local (USB) to 
open the configuration window. 

The initial screen presents two connection options: 

• Auto Connect – Automatically detects the connected FM 
301 

• Select COM Port – Allows manual selection of the 
appropriate COM port 

Once connected, the current configuration of the FM 301 will be 
displayed. 
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The following parameters can be adjusted: 

• Trigger levels for vibration and air overpressure 

• Recording duration 

• Accelerometer range 

• Trigger enable/disable options for velocity and  air 
overpressure  

Clicking Default Setup will apply the following default settings: 

• Vibration trigger: 0.5 mm/s 

• Air overpressure trigger: 115 dB(L) 

• Duration: 4 seconds 

The Clock section displays the unit’s internal time. The UTC 
offset can be set to reflect the local time zone at the monitoring 
location. 

Click Send to Seismograph to apply and save the updated 
configuration. 

Setup :  Software 

Selecting Setup → Software opens a window for configuring how 
data is displayed and interpreted within the V-Blast software 
environment. 
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The following settings can be adjusted: 

• Colour scheme for waveform displays 

• Units: Metric or Imperial 

• Display of peak resultant values 

• Vibration monitoring standard 

• Air overpressure monitoring standard 

Colour options can be modified by clicking the colour swatch next 
to each parameter. 

Note : The reported peak values for vibration and air overpressure 
are dependent on the selected monitoring standard. These may 
differ from the provisional results shown in the Android App. 

 
Note : The original raw waveform data is preserved in the .FMD 
file. Any vibration or overpressure values exported to CSV are 
filtered based on the selected monitoring standards. 

 

Waveform Display 

Any .FMD file saved using the V-Blast software can be opened for 
review by selecting File → Open from the main menu. 

The waveform will be displayed in a new window, with graphical 
plots for vibration and air overpressure. By default, the velocity 
trace is shown, but this can be toggled to acceleration using the 
Acceleration button or displacement using the Displacement 
button . 
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If a valid GPS signal was present during recording, GPS time 
pulses will appear along the bottom of the display. 

The following information is shown alongside the waveform: 

• Date and time the event was recorded 

• Time source: Either the unit’s internal clock (RTC) or 
GPS signal (UTC) 

• FM 301 serial number 

• Last calibration date 

• GPS coordinates (if available) 

• User comments (up to 4 lines) 

• Comments can be added directly within the display 
window by clicking on a line and typing. 

Note: To save any entered comments, select File → 
Save. Unsaved comments will be lost when the window 
is closed. 

• Results table, including: 

• Peak values for each vibration component (velocity, 
acceleration, displacement) 

• Nominal frequencies 
• Peak air overpressure reading 
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• Applied monitoring standards 

The waveform view includes options for: 

• Printing (via the printer icon or PDF export) 

• Zooming (via the magnifying glass icon) 

• Frequency analysis 

• Signal filtering 

Printer Icon 

Clicking the printer icon initiates the print process for the 
displayed waveform and associated data. 

The output will be sent to the default or selected printer connected 
to the computer. 

If a PDF printer is installed, a digital copy of the waveform can be 
generated as a PDF. 

Magnifying Glass Icon – Zoom Function 

Clicking the magnifying glass icon opens the Zoom Tool, which 
provides a detailed view of the waveform for closer inspection. 

• A solid vertical line marks the current signal location 

• The blue slider at the bottom of the window allows 
panning left or right across the waveform. 
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Keyboard Navigation: 

• ← / → : Move one sample at a time 

• Pg Up / Pg Dn : Move in larger increments 

• Home / End : Move to the start or end of the waveform 
 

Clicking the clock icon in the upper-left sets the time at the current 
location to zero, marked by a dashed line. 

Time and frequency values displayed are relative to this point. 

Click the clipboard icon in the upper-right corner to copy the 
displayed data to the computer’s clipboard. 

Frequency Analysis 

Clicking the Frequency Analysis tab opens a window that displays 
the frequency content of the selected waveform segment. 
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A blue slider at the bottom of the window allows panning left or 
right across the signal. 

Keyboard Navigation: 

• ← / → : Move one sample at a time 

• Pg Up / Pg Dn : Move in larger increments 

• Home / End : Move to the start or end of the signal 

Three frequency range options are available: 

• 50 Hz  

• 100 Hz 

• 200 Hz 

A drop-down menu in the upper-right corner allows selection of 
the frequency analysis standard to apply (e.g. USBM RI 8507, 
among others). 
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To generate a hard copy or digital output, click the printer icon. If 
a PDF printer is installed, the analysis can be exported as a PDF.  

Filter 

Clicking the Filter tab opens a new window for applying frequency 
filters to the selected waveform. 
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Available options include: 

• High-pass and low-pass filters 

• Cutoff frequency selection to isolate or remove specific 
frequency ranges 

After selecting the desired filter settings, click Apply Filter. A new 
window will display the filtered signal. 

To revert to the original, unfiltered waveform, click the green 
reverse arrow in the upper-right corner of the screen. 
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Chapter 5 – FM 301 Android App 

Downloading and installing FM Seismograph App  
The FM Seismograph application can be downloaded from Google 
Play Store by searching for ‘FM Seismograph’.   

Note : the App is accessible in specific countries only.  

Using the FM Seismograph App  
The initial screen that is displayed when the App is run, is below. 
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Towards the top of the display is a status line which reflect the 
current situation with the App and any connection to a FM 301. In 
the example this is showing ‘No Connection’. 

Below the status line is a row of buttons with icons and then below 
that a simple description of the meaning of each button. A more 
detailed explanation is given on subsequent pages in this manual. 
The help screen will disappear when a connection is made. 

If the buttons are shown in light grey this means they are disabled. 

Connect to FM 301 

When this button is pressed the App will look for any FM 301 units 
that are nearby and then display a list of the devices found. You 
should select from the list the FM 301 that you wish to connect to. 
The list of possible devices shows a long name for each, but you 
should see towards the end of the name ‘FM301’ followed by a 4 
digit serial number. 

The connection process is not always successful and you may need 
to try several times. The closer you are to the FM 301 the better 
and certainly not more than 5m away. 

When a connection has been made the screen will be updated and 
the status line should show the FM 301 that is connected. A Data 
Log table will also be displayed showing a summary of the last 3 
events recorded. In addition, a Seismograph Status section will 
appear showing the serial number, battery level, sampling rate, 
recording window size, trigger levels and GPS data. 

The battery level displays the approximate number of operating 
hours. The battery level is also colour coded and will be green for 
high, yellow for medium and pink for low. If the level is shown as 
pink then you will have less than one hour of monitoring left and 
the unit may stop monitoring at any time. 

If triggering from one or both vibration and air overpressure has 
been disabled then the display will show ‘Disabled’ on a yellow 
background. 

If there is no valid GPS signal then the display will show ‘No Fix’ 
on a yellow background otherwise the Latitude and Longitude will 
be shown. 

Note : The display only reflects the status of the FM 301 at the 
moment of connection and is not continuously updated. 
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When a connection has been made and the FM 301 detects an event 
the FM 301 will notify the App of the event after it has been 
processed and stored. This notification will be shown on the screen 
even if another application is being run. The data log screen will 
also be automatically updated. 

Note : The reported peak values are provisional and may change 
with the application of the relevant national monitoring standards 
when downloaded to the V-Blast software for processing. 

Disconnect from FM 301 

Pressing this button will cause the FM 301 to be disconnected and 
the App will return to the opening screen. 

Update Log and Status Screens 

Pressing this button will update the display.  

Note : The updating process means that monitoring will be 
suspended for a fraction of a second and that if this is done just 
before a blast you can get a gap in the data. It is suggested that you 
do not do an update after the final blast warning has been given. 

Adjust Trigger Levels  

Pressing this button allows you to adjust the trigger levels for FM 
301 and will display a new section with the title ‘Trigger Settings’.  

The current trigger levels will be shown along with corresponding 
Up and Down Arrow buttons.  

The trigger levels can be adjusted up and down with these buttons. 
As soon as a change has been made a new button will appear 
pointing to the right.  

Pressing this button will send the corresponding trigger setting to 
the FM 301. 

If the vibration trigger level is set to less than 0.5 mm/s then it will 
be shown on a yellow background as a warning of the risk of false 
triggers. The corresponding value for the air overpressure is 108 
dB(L). If the trigger levels are taken very low then the trigger will 
be disabled and shown on a yellow background. 

When the window is closed an automatic update is carried out on 
the Seismograph Status display. 
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Disabling Trigger 

Pressing this button at any time will immediately disable 
triggering and stop the monitoring process. This should only be 
used if the background levels of vibration or air overpressure are 
above the trigger levels and the unit is continuously triggering. The 
trigger levels can then be adjusted as previously described. 

Send Results by Text Message 

Pressing this button allows for a summary of the results to be sent 
by text message. You will be asked to select from the 3 events 
displayed (multiple events can be selected). A Site Name can be 
added to the message along with a Monitoring Location. The 
telephone number for the message is selected from your phones 
contact list. 

View Location on a Map 

Pressing this button will show the reported location of the FM 301 
on a map. This button will be disabled if there is no GPS fix. 

Requires active data connection or WIFI connection on mobile 
phone. 

Close Application 

Pressing this button will close the application down and disconnect 
any connected devices. 

Adjust App Settings 

Pressing this button will open a new screen that allows you to 
adjust various settings. 

Included in the permitted changes are: 

• PPV Units : Choose from mm/s [millimetres per second] 
or i.p.s. [inches per second]. 

• Air Overpressure Units : Choose from Pa [Pascals], dB(L) 
[decibels linear], mbar [millibars] or p.s.i. [pounds per 
square inch]. 

• Date Format : Choose from dd/mm/yyyy [day/month/ 
year] or mm/dd/yyyy [month/day/year]. 
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You can also set a beep and/or vibrate for a button press or event 
notification. 

Pressing the Save button on this screen will ensure the same 
settings will be used in the future. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



Blast Log Ltd 26 

 

FM 301 Blasting Seismograph - Instruction Manual    •   26 
 

Appendix 1 – Specifications 

FM 301 Specifications  

Data Channels 

3 x Acceleration and 1 x Air Overpressure 
3 x Velocity generated by on board integration of acceleration 
channels 

Acceleration Frequency Response  

2.47 Hz to 250 Hz at a sampling frequency of 1.0 kHz 

Air Overpressure Frequency Response  

1 to 250 Hz  

Resolutions (nominal and subject to calibration) 

Acceleration : 0.0374 mm/sec2 
Velocity : 0.01 mm/sec 
Air Overpressure : 0.12 Pa   

Ranges 

Acceleration : 78500 mm/sec2 or 8g 
Velocity : 314 mm/s at 10 Hz to 31.4 mm/s at 100 Hz  
Max. velocity range: +/- 327 mm/s (12.9 in/s) 
Air Overpressure : 1000 Pa or 154 dB(L) 

Triggering  

Vibration velocity : from 0.1 mm/s upwards in 0.1 mm/s steps 
Air overpressure : from 2 Pa (104 dB(L)) upwards in 1 Pa steps  
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Pre-Trigger Recording 

Sample Rate 1.0 kHz 

Pre-Trigger 0.512 
seconds 

Recording Windows 

Sample 
Rate 

2 
second 

4 
second 

8 
second 

1.0 kHz Yes Yes Yes 

Storage Capacity 

1000 full waveform recordings  

Clock 

On-board real time clock accurate to 10 seconds 
GPS clock accurate to better than 1 microsecond  

Interfaces 

USB 2.0 to Windows software 
Bluetooth Low Energy to Android application for mobile devices  

Integrated GNSS 

GPS  

Bluetooth 

FCC IDENTIFIER: SH6MDBT40 
NAME OF GRANTEE: Raytac Corp. 
EQUIPMENT CLASS: Digital Transmission System 
NOTES: Bluetooth Module 
MODULAR TYPE: Single Modular 

Dimensions 

160 mm x 138 mm x 55 mm (6.3 in x 5.4 in x 2.2 in)  
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Weight 

0.85 kg 

V-Blast Specifications  

Minimum Requirements  

Microsoft Windows 10 operating system 

International Vibration Monitoring Standards Included 

AS 2187: 2 to 250 Hz  
BS 7385: 1 to 150 Hz 
ISEE: 2 to 250 Hz  
ISO 4866: 1 to 150 Hz 
 

International Air Overpressure Monitoring Standards 
Included 

AS 2187: 2 to 250 Hz  
ISEE: 2 to 250 Hz  
 

Velocity Frequency Damage Criteria Included 

BS 7385 Part 2 
DIN 4150-3  
OSM CFR 30 
USBM RI 8507 
UNE 22-381-93 

 

FM Seismograph App Specifications  

Minimum Requirements  

Android 5 
 

 



  

 

Blast Log FM 301 Blasters’ Seismograph Warranty 
 

The Blast Log FM 301 blasters’ seismograph comes with a one year warranty from the date 
of delivery to the purchaser. The warranty only applies to the original purchaser and is not 
transferrable. This warranty guarantees that any FM 301 unit manufactured or sold by Blast 
Log Limited is free from defect, whether this relates to materials or workmanship.  Blast Log 
Ltd undertakes to repair or replace free of charge, any part of the FM 301 unit, provide that 
the unit has been used in accordance with Blast Log’s published specifications and the 
operator’s manual. This warranty is void if the equipment has been neglected, dismantled, 
altered or abused in any way. Any transportation charges back to the Blast Log office to be 
payable by the customer. However on receipt of shipping documentation relating to the FM 
301 unit, these costs will be refunded by Blast Log Limited. All transport costs relating to 
return of the unit will be payable by Blast Log Limited.  

It should be borne in mind that the FM 301 blasters’ seismograph is an electronic instrument. 
Although the unit is robust, in that it has been specifically designed for field use, it contains 
sensitive components which cannot be expected to withstand the same stress and shock as 
construction tools or heavy machinery. The battery is not intended to be replaced by the 
operator. The unit should be returned to Blast Log Limited to be serviced. Any attempt to 
service this product will void any and all warranties offered by Blast Log Limited. 

 

 

 

 

 

 

 

 

 

 

 

 



 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 

 

tel  

e-mail 
 

web 

  
  Alberma House   

30 Grovehall Parade   
Beeston, Leeds   
West Yorks., LS11 7AE   
+44 (0)1 133 859870   
info@blastlog.co.uk 
 

   

  

www. blastlog.co.uk   

Leeds Office:   
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